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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Curiosity Development Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the Curiosity Development Board as a 
development tool to emulate and debug firmware on a target board. The document is 
organized as follows:
• Chapter 1. “Introduction to Curiosity” – This chapter contains general 

information regarding the Curiosity Development Board kit contents, layout and 
power source.

• Chapter 2. “Getting Started” – This chapter offers information on how to 
program the Curiosity Development Board.

• Chapter 3. “Troubleshooting” – Consult this chapter for troubleshooting 
information.

• Appendix A. “Schematic” – This appendix lists the Curiosity Development 
Board schematic.

• Appendix B. “General Notes” – Refer to this appendix for general notes on 
power options, configuration of the RN4020 Bluetooth® low-energy module and 
the Click module, debugging, routing and flexibility of the board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE 

This manual uses the following documentation conventions:

DOCUMENT CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user’s guide describes how to use the Curiosity Development Board. For the latest 
information on using other tools, refer to the MPLAB® X IDE home page: 
www.microchip.com/mplabx/. This resource page contains updated documentation, 
downloads and links to other MPLAB X compatible tools, plug-ins and much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes, sample programs 
and labs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software
Curiosity Development board-specific product support can be accessed via our 
website at www.microchip.com/curiosity.

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program mem-
ber listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 
debug express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART® Plus and 
PICkit 2 and 3.

http://www.microchip.com
http://www.microchip.com
http://www.microchip.com/curiosity
http://www.microchip.com/curiosity
http://www.microchip.com/pagehandler/en-us/family/mplabx/home.html
http://www.microchip.com/pagehandler/en-us/family/mplabx/home.html
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers.

Technical support is available through the website at: 

www.microchip.com/support.

REVISION HISTORY

Revision C (September 2019)

Updated Figures 2-1 through 2-4 and A-1.

Remove EU Declaration of Conformity.

Revision B (April 2016)

Added the EU Declaration of Conformity.

Revision A (July 2015)

Initial release of this document.

http://www.microchip.com/support/hottopics.aspx
http://www.microchip.com/support/hottopics.aspx
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Chapter 1.  Introduction to Curiosity 

The Curiosity Development Board supports Microchip’s 8-, 14- and 20-pin 8-bit PIC® 
MCUs. Dual-row expansion headers on either side of the socket offer flexibility of 
connectivity to all pins on the PIC MCUs. This board provides flexibility for 
experimentation through an application header with ground (GND) and supply voltage 
(VDD) connections. It also includes a set of indication LEDs, mTouch® button and push 
button switches, and a variable potentiometer. Additionally, it features a Bluetooth® 
low-energy footprint and a mikroBUS™ footprint to accommodate a variety of plug-in 
Click board™ sensors that can be used in application development.

1.1 CURIOSITY DEVELOPMENT BOARD KIT CONTENTS
The Curiosity Development Board kit contains the following: 

• Curiosity Development Board 

• Quick Start Guide

FIGURE 1-1: CURIOSITY DEVELOPMENT BOARD KIT

mTouch®
Button

™
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1.2 CURIOSITY DEVELOPMENT BOARD LAYOUT

Figure 1-2 identifies the major features of the Curiosity Development Board.

FIGURE 1-2: CURIOSITY DEVELOPMENT BOARD LAYOUT

mTouch®
Button

21 3 5 6 7 8

910111213

1. USB mini-B connector (on back)

2. Footprint for 9V connector

3. Master Clear Reset button

4. 3.3/5V power jumper (J12)

5. Posts for external variable power supply

6. Expansion board connector 

7. PIC® MCU socket for 8, 14, and 20-pin microcontrollers

8. mikroBUS™ Click board™ footprint for application development

9. RN4020 Bluetooth® module footprint

10. Potentiometer

11. LEDs

12. mTouch® button

13. Push button

™

4
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1.3 POWER SOURCES

The Curiosity Development Board can be powered in one of three ways, depending on 
its usage.

1.3.1 USB Connector (J2)

The USB connector (J2) will power the entire Curiosity Development Board. A shunt 
jumper must be placed onto jumper J12 (Figure 1-2). The right two pins of J12 will 
connect +5V from the USB connector J2. The left two pins of J12 will connect +3.3V 
from the USB voltage regulator on the back side of the development board. With USB 
power connected to J2, power LED D1 will always be ON to indicate that +3.3V is 
available on the board. 

1.3.2 9V External Power Supply (J15)

The 9V external power supply (J15) will also power the entire Curiosity Development 
Board. A shunt jumper must be placed onto jumper J12 (Figure 1-2). The right two pins 
of J12 will connect +5V from the on-board voltage regulator circuitry connected to 
connector J15. The left two pins of J12 will connect +3.3V from the on-board voltage 
regulator circuitry. With 9V external power connected to J15, power LED D1 will always 
be ON to indicate that +3.3V is available on the board. Power LED D2 will only be ON 
when power (+3.3V or +5V) is applied to VDD via a shunt jumper placed on J12.

1.3.3 Variable External Power Supply (TP3, TP4)

A variable external power supply connected to TP3 and TP4 will power the entire 
Curiosity Development Board. A shunt jumper is not needed on J12, thus either +3.3V 
or +5V can be directly applied via a variable external power supply to VDD.
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Chapter 2.  Getting Started

The Curiosity Development Board must be used with MPLAB X Integrated 
Development Environment (IDE), available free on Microchip’s website, 
www.microchip.com. Use version v3.05 or later. 

The Curiosity Development Board, through MPLAB X, is a low-voltage in-circuit 
debugger, as well as a low-voltage programmer, for all supported devices. In-circuit 
debugging allows the user to run, examine and modify programs for the supported 
device embedded in the Curiosity hardware. This facilitates the debugging of firmware 
and hardware concurrently. Use the Curiosity Development Board with MPLAB X IDE 
to run, stop and single-step through programs –breakpoints can be set and the 
processor can be reset. When the processor stops, the contents of the register are 
available for examination and modification.

2.1 PROGRAMMING THE CURIOSITY DEVELOPMENT BOARD

After connecting the Curiosity Development Board to the computer using the on-board 
USB connector (J2 on the back of the board), open the MPLAB X IDE. Then create a 
new project or open an existing project. Click on the Project Properties icon located in 
the project’s Dashboard window (Figure 2-1). Alternatively, the Project Properties 
window can be opened by clicking on File > Project Properties, or by right-clicking on 
the project name in the Projects window and clicking Properties. (Figure 2-1).

FIGURE 2-1: SELECTING THE CURIOSITY DEVELOPMENT BOARD IN THE MPLAB® X IDE 

http://www.microchip.com/
http://www.microchip.com/
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MPLAB X refers to the Curiosity Development Board as “Starter Kits (PKOB)”, with 
“Curiosity” listed below. Click on Curiosity, the correct device and XC8 compiler 
version being used, then click Apply (Figure 2-2). On the upper left hand corner of the 
Properties window, click on Starter Kit (PKOB) (Figure 2-3). The window will change 
to the Options for Starter Kit (PKOB) window (Figure 2-3).

FIGURE 2-2: CURIOSITY DEVELOPMENT BOARD CONFIGURATION 

FIGURE 2-3: PROGRAM OPTIONS FOR STARTER KIT (PKOB)
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Select options category “Program Options” and then “Enable Low-Voltage 
Programming,” if it is not already selected. Click Apply, then OK (Figure 2-3). Once the 
project is finished, the microcontroller is ready to be programmed. Simply click on the 
Make and Program Device Main Project button and the device will be programmed 
(Figure 2-4).

FIGURE 2-4: PROGRAMMING THE DEVICE ON THE CURIOSITY DEVELOPMENT BOARD

Note:  When using the PKOB for programming, the Low-Voltage Programming 
(LVP) bit of the Configuration Word(s) must be set (LVP = ON or ‘1’).



 2015-2019 Microchip Technology Inc. DS40001804C-page 14

CURIOSITY DEVELOPMENT BOARD
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Chapter 3.  Troubleshooting

This chapter discusses common operational issues and how to resolve them.

3.1 THE DEMO APPLICATION DOES NOT RUN

The Curiosity Development Board must be plugged into a powered USB hub, com-
puter, or other USB host device. To run the application, ensure the conditions listed 
below are met:

1. Start by plugging it into the USB device port, J2. LEDs D1 and D2 should light 
when VBUS is detected.

2. If D1 is not lit, verify that the USB host side port is functional.

3. If D2 is not lit, verify that jumper J12 is connected to the proper device voltage.

3.2 THE MCU WILL NOT PROGRAM USING THE PKOB

The Curiosity Development Board’s PICkit™ On-Board (PKOB) uses low-voltage 
programming. The demo application code sets the Low-Voltage Programming (LVP) bit 
to a ‘1’, allowing low-voltage programming. 

1. When using custom firmware, the LVP bit must be set to ‘1’ in the Configuration 
Word. MPLAB X will not allow programming using the PKOB unless the bit is 
properly configured.

2. When using a PIC microcontroller (one not included with the Curiosity 
Development Board) that has already been programmed using high-voltage 
programming and the LVP bit cleared (LVP = OFF or ‘0’), the device will not be 
recognized and cannot be programmed using the PKOB. Reprogramming the 
device can be achieved by one of the following two methods:

a) Connect a PICkit 3 Programmer to the Curiosity board, configuring MPLAB 
to use the PICkit 3 as the programmer, and ensuring the LVP bit is set to ‘1’ 
in the Configuration Word. Reprogram the device.

b) Use an unprogrammed (blank) device and ensure the LVP bit is set to ‘1’ in 
the Configuration Word.

3.3 THE MCU WILL NOT PROGRAM USING THE PICkit™ 3

If the PIC device will not program using the PICkit 3, ensure that the 3.3/5V jumper 
(J12) is removed.



 2015-2019 Microchip Technology Inc. DS40001804C-page 15

CURIOSITY DEVELOPMENT BOARD
USER’S GUIDE

Appendix A. Schematic

A.1 CURIOSITY DEVELOPMENT BOARD SCHEMATIC

FIGURE A-1: CURIOSITY DEVELOPMENT BOARD SCHEMATIC
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Table A-1 lists the parts that are not included with the Curiosity Development Board.

TABLE A-1: PARTS NOT INCLUDED WITH THE CURIOSITY DEVELOPMENT BOARD

Item
Manufacturing Part 

Number
Manufacturer Digi-Key Part Number Description

J15 PJ-002BH-SMT CUI Inc. CP-002BHPJDTR-ND CONN POWER JACK 
2.5X5.5 mm HI CUR

U5 LM340MP-5.0/NOPB TI LM340MP-5.0/NOPBTR-ND IC REG LDO 5V 1A 
SOT223

J33, J34 PPTC081LFBN-RC Sullins Connector 
Solutions

S7006-ND CONN HEADER 
FEMALE 8POS .1" TIN

J7 PPTC061LFBN-RC Sullins Connector 
Solutions

S7004-ND CONN HEADER 
FEMALE 6POS .1" TIN

J8, J10, J14 PRPC008SAAN-RC Sullins Connector 
Solutions

S1011EC-08-ND CONN HEADER .100" 
SNGL STR 8POS

J13, J39, J40 PRPC004DAAN-RC Sullins Connector 
Solutions

S2011EC-04-ND CONN HEADER .100" 
DUAL STR 8POS

J3, J4, J5, J6 PREC002SAAN-RC Sullins Connector 
Solutions

S1012EC-02-ND CONN HEADER .100" 
SNGL STR 2POS
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CURIOSITY DEVELOPMENT BOARD
USER’S GUIDE

Appendix B. General Notes

B.1 POWER

When the Curiosity board is USB-powered through a 5V supply rather than a USB port 
on a computer, MCLR is held in Reset for approximately five seconds.

B.2 RN4020 BLUETOOTH® LOW ENERGY (BLE) MODULE

1. The RN4020 Bluetooth Low Energy (BLE) module must be configured before 
use. This can be achieved by either of the following methods:

a) Connecting the UART TX and RX lines to an external UART-to-USB bridge, 
such as the MCP2200, and using a terminal program to communicate with 
and program the BLE module

b) Writing custom firmware and programming the BLE module through the PIC 
MCU.

2. The Wake_HW line (pin 15 of the RN4020) was not connected, but is now 
recommended. This line must be connected for proper BLE functionality. See the 
RN4020 Bluetooth® Low Energy Module Command Reference User’s Guide 
(DS70005191) for more information.

B.3 CLICK OR RN4020 MODULES

Shared UART TX and RX lines supply connection to either the RN4020 BLE module or 
a Click module (which uses UART for communication with the PIC MCU), but not both.

B.4 DEBUGGING MODE

During Debug mode, LED D5 is not available to the user. This was done to provide 
out-of-the-box LED access to Microchip’s 8-pin MCUs. There are zero-ohm-resistors in 
series that can be removed to allow connection to another pin, if desired.

B.5 ROUTING AND FLEXIBILITY

Pinouts to the various connections provide connectivity to many devices. With 
zero-ohm resistors in series to all connections (i.e., the mikroBUS™, TouchPad, and 
LEDs), the board can be modified for many situations without cutting the printed circuit 
board (PCB) traces.



 2015-2019 Microchip Technology Inc. DS40001804C-page 18

AMERICAS
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200 
Fax: 480-792-7277
Technical Support: 
http://www.microchip.com/
support
Web Address: 
www.microchip.com

Atlanta
Duluth, GA 
Tel: 678-957-9614 
Fax: 678-957-1455

Austin, TX
Tel: 512-257-3370 

Boston
Westborough, MA 
Tel: 774-760-0087 
Fax: 774-760-0088

Chicago
Itasca, IL 
Tel: 630-285-0071 
Fax: 630-285-0075

Dallas
Addison, TX 
Tel: 972-818-7423 
Fax: 972-818-2924

Detroit
Novi, MI 
Tel: 248-848-4000

Houston, TX 
Tel: 281-894-5983

Indianapolis
Noblesville, IN 
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380

Los Angeles
Mission Viejo, CA 
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800 

Raleigh, NC 
Tel: 919-844-7510

New York, NY 
Tel: 631-435-6000

San Jose, CA 
Tel: 408-735-9110
Tel: 408-436-4270

Canada - Toronto
Tel: 905-695-1980 
Fax: 905-695-2078

ASIA/PACIFIC
Australia - Sydney
Tel: 61-2-9868-6733

China - Beijing
Tel: 86-10-8569-7000 

China - Chengdu
Tel: 86-28-8665-5511

China - Chongqing
Tel: 86-23-8980-9588

China - Dongguan
Tel: 86-769-8702-9880 

China - Guangzhou
Tel: 86-20-8755-8029 

China - Hangzhou
Tel: 86-571-8792-8115 

China - Hong Kong SAR
Tel: 852-2943-5100 

China - Nanjing
Tel: 86-25-8473-2460

China - Qingdao
Tel: 86-532-8502-7355

China - Shanghai
Tel: 86-21-3326-8000 

China - Shenyang
Tel: 86-24-2334-2829

China - Shenzhen
Tel: 86-755-8864-2200 

China - Suzhou
Tel: 86-186-6233-1526 

China - Wuhan
Tel: 86-27-5980-5300

China - Xian
Tel: 86-29-8833-7252

China - Xiamen
Tel: 86-592-2388138 

China - Zhuhai
Tel: 86-756-3210040 

ASIA/PACIFIC
India - Bangalore
Tel: 91-80-3090-4444 

India - New Delhi
Tel: 91-11-4160-8631

India - Pune
Tel: 91-20-4121-0141

Japan - Osaka
Tel: 81-6-6152-7160 

Japan - Tokyo
Tel: 81-3-6880- 3770 

Korea - Daegu
Tel: 82-53-744-4301

Korea - Seoul
Tel: 82-2-554-7200

Malaysia - Kuala Lumpur
Tel: 60-3-7651-7906

Malaysia - Penang
Tel: 60-4-227-8870

Philippines - Manila
Tel: 63-2-634-9065

Singapore
Tel: 65-6334-8870

Taiwan - Hsin Chu
Tel: 886-3-577-8366

Taiwan - Kaohsiung
Tel: 886-7-213-7830

Taiwan - Taipei
Tel: 886-2-2508-8600 

Thailand - Bangkok
Tel: 66-2-694-1351

Vietnam - Ho Chi Minh
Tel: 84-28-5448-2100

EUROPE
Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

Denmark - Copenhagen
Tel: 45-4450-2828 
Fax: 45-4485-2829

Finland - Espoo
Tel: 358-9-4520-820

France - Paris
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79 

Germany - Garching
Tel: 49-8931-9700

Germany - Haan
Tel: 49-2129-3766400

Germany - Heilbronn
Tel: 49-7131-72400

Germany - Karlsruhe
Tel: 49-721-625370

Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44

Germany - Rosenheim
Tel: 49-8031-354-560

Israel - Ra’anana 
Tel: 972-9-744-7705

Italy - Milan 
Tel: 39-0331-742611 
Fax: 39-0331-466781

Italy - Padova
Tel: 39-049-7625286 

Netherlands - Drunen
Tel: 31-416-690399 
Fax: 31-416-690340

Norway - Trondheim
Tel: 47-7288-4388

Poland - Warsaw
Tel: 48-22-3325737 

Romania - Bucharest
Tel: 40-21-407-87-50

Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91

Sweden - Gothenberg
Tel: 46-31-704-60-40

Sweden - Stockholm
Tel: 46-8-5090-4654

UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820

Worldwide Sales and Service

05/14/19

http://support.microchip.com
http://www.microchip.com

	Curiosity Development Board
	Table of Contents
	Introduction
	Document Layout
	Conventions Used in this Guide
	Recommended Reading
	The Microchip Website
	Development Systems Customer Change Notification Service
	Customer Support
	Revision History

	Chapter 1. Introduction to Curiosity
	1.1 Curiosity Development Board Kit Contents
	Figure 1-1: Curiosity Development Board Kit

	1.2 Curiosity Development Board Layout
	Figure 1-2: Curiosity Development Board Layout

	1.3 Power Sources
	1.3.1 USB Connector (J2)
	1.3.2 9V External Power Supply (J15)
	1.3.3 Variable External Power Supply (TP3, TP4)


	Chapter 2. Getting Started
	2.1 Programming the Curiosity Development Board
	Figure 2-1: Selecting the Curiosity Development Board in the MPLAB® X IDE
	Figure 2-2: Curiosity Development Board Configuration
	Figure 2-3: Program Options for Starter Kit (PKOB)
	Figure 2-4: Programming the Device on the Curiosity Development Board


	Chapter 3. Troubleshooting
	3.1 The Demo Application Does Not Run
	3.2 The MCU Will Not Program Using The PKOB
	3.3 The MCU Will Not Program Using the PICKIT™ 3

	Appendix A. Schematic
	Table A-1: Parts not included with the Curiosity Development Board

	Appendix B. General Notes
	Worldwide Sales

